
Epson Stylus Photo R220

Printer Basics

®

R220.book  Page 1  Sunday, August 7, 2005  3:41 PM



2

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be 
misused by improper copying or printing of copyrighted material. While some countries’ laws 
permit limited copying of copyrighted material in certain circumstances, those circumstances may 
not be as broad as some people assume. Epson encourages each user to be responsible and respectful 
of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks
Epson, Epson Stylus, MicroWeave, and Epson Photo Stickers are registered trademarks of Seiko 
Epson Corporation.

BorderFree, RPM, and ColorLife are registered trademarks, PhotoEnhance and Print Lab are 
trademarks, and Epson Connection, Epson Store, and SoundAdvice are service marks of Epson 
America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.
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Welcome

Your Epson Stylus® Photo R220 is a full-featured photo and CD/DVD printer. 
You get outstanding prints from these advanced features:

■ Epson’s exclusive 6-color ink technology lets you achieve fine shadow detail, 
dazzling highlights, and excellent fill across a wide range of colors. Genuine 
Epson® ink and papers create long-lasting and water-resistant prints.

■ CD and DVD printing on ink jet-printable CDs and DVDs.

■ True BorderFree® frame-ready prints on select 4 × 6, 5 × 7, 8 × 10, and letter-
size papers.

■ A standard rear USB port plus a front USB port for quick connection to
your laptop.

Note: 

The front USB port does not support digital cameras or other USB devices.

Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG/TIFF files so your printer and application can use 
them to create accurate print settings. Most digital cameras store Exif Print 
information such as shutter speed, metering, flash, exposure settings, resolution, 
and lens use in the JPEG/TIFF image file. Your printer uses the information to 
ensure the most accurate image reproduction.

R220.book  Page 5  Sunday, August 7, 2005  3:41 PM



6 Welcome

About Your Documentation

To set up your printer and install its software, see the Start Here sheet.

This book contains instructions on loading paper, printing with Windows® and 
Macintosh,® printing borderless photos, printing on CDs and DVDs, maintaining 
your printer, and solving basic problems.

For more information about your printer, double-click the SPR220 Reference 
Guide icon on your desktop.

Please follow these guidelines throughout:

Warning: 

Warnings must be followed carefully to avoid bodily injury.

Caution: 

Cautions must be observed to avoid damage to your equipment.

Note: 

Notes contain important information about your printer.

Tip: 

Tips contain hints for better printing.
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Printing From Start to Finish

Loading Paper

The type of paper you choose affects the way your printout looks, so be sure to 
select the correct paper for your job. If you are just printing a rough draft, plain 
paper is fine. For the best results, you’ll want to use one of Epson’s special ink jet 
papers designed for your printer. For example, your photos will look great printed 
on Epson Ultra Premium Glossy Photo Paper. See “Selecting the Correct Paper 
Type” on page 17 for more information.

Follow these steps to load paper in your printer.

1. Open the output tray and its extension.

2. Insert paper, printable side up, against the right edge guide behind the tab.

3. Slide the left edge guide against the paper (but not too tightly).

8 × 10-inch or
Letter-size paper

4 × 6-inch or 
5 × 7-inch paper

R220.book  Page 7  Sunday, August 7, 2005  3:41 PM



8 Printing From Start to Finish

Follow these guidelines when loading paper:

■ Load the printable side face-up. It’s often brighter or whiter than the
other side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Always load the short edge first, even when printing in landscape mode.

■ Don’t load paper above the arrow on the left edge guide.

■ If you’re using special paper, follow the instructions that came with it.

■ If the paper has a cut corner, position it in the upper right corner as you load 
it in the sheet feeder.

■ To load Epson ink jet papers, follow these guidelines:

Paper Type Loading Capacity

Premium Bright White Paper

Photo Quality Ink Jet Paper

100 sheets

Photo Quality Ink Jet Cards 30 cards

Matte Paper Heavyweight

Glossy Photo Paper

ColorLife® Photo Paper

Ultra Premium Glossy Photo Paper

Premium Glossy Photo Paper

Premium Semigloss Photo Paper

Premium Luster Photo Paper

Semigloss Scrapbook Photo Paper

PremierArtTM Matte Scrapbook Photo Paper

20 sheets

Double-Sided Matte Paper

Iron-On Transfer Paper

Glossy Photo Greeting Cards

Photo Stickers

Photo Quality Self Adhesive Sheets

Ink Jet Transparencies

1 sheet
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Printing in Windows 9

Printing in Windows

Follow the instructions in this section to print a document or photo using basic 
print settings. For instructions on printing borderless photos, see page 18. For 
instructions on printing with Advanced print settings, see your on-screen 
Reference Guide.

1. From the File menu, click Print.

2. Make sure EPSON Stylus Photo R220 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the 
next screen.)

Select your printer here

Click here to open 
your printer software
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10 Printing From Start to Finish

You see the basic print settings window:

4. Select from these Quality Option settings:

Draft: For rough drafts with reduced print quality

Text: For text-only documents with higher text quality

Text & Image: For documents with text and images with higher quality

Photo: For photos and graphics with good quality and speed

Best Photo: For photos or graphics with high print quality

5. Make sure the paper Type and Size settings match the paper you’ve loaded in 
the printer. See “Selecting the Correct Paper Type” on page 17.

6. Select Portrait or Landscape for the Orientation setting.

Select the type of document you’re printing

Select your 
paper Type

Click here 
for more 
options

Select your 
document 
or image 
orientation

Select your 
paper Size
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Printing in Windows 11

7. For more printing options, click the Advanced button. Then select the 
following settings as necessary.

Note: 

For more information about advanced settings, or instructions on saving them as a 
group so you can reuse them later, click ? or Help.

8. If you want to change the layout settings, click the Page Layout tab and 
select settings as necessary.

9. Click OK to save your settings, then click OK or Print to start printing.

Click here if you want to see this Advanced 
screen each time you access your print settings

Select Print Options 
as necessary

Click here to select 
Photo RPM® for the 
best print quality on 
certain paper types

Select Paper & Quality 
Options as necessary

Select a color management method
(To choose No Color Adjustment, click ICM first)
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12 Printing From Start to Finish

During printing, this window appears and shows the progress of your print job. 
You can use these buttons to cancel, pause, or resume printing. You can also see 
how much ink you have left.

Tip: 

You can also cancel printing by pressing the ) paper button on your printer.

Selecting Default Settings

Your printer settings only apply to the program that you’re currently using. If you 
want, you can change the Windows default printer settings for all your programs. 

1. Right-click the  icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown on page 10.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Click to cancel printing

Click to pause or resume printing
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Printing With a Macintosh 13

Printing With a Macintosh

Follow the instructions in this section to print a document or photo using basic 
print settings. For instructions on printing borderless photos, see page 18. For 
instructions on printing with Advanced print settings, see your on-screen
Reference Guide.

Before you begin, make sure you added your printer to the Printer Setup Utility or 
Print Center as described on the Start Here sheet. 

1. From the File menu, select Page Setup. You see the Page Setup window:

2. Select Stylus Photo R220 from the Format for pop-up menu.

3. Select your Paper Size and Orientation.

4. Click OK to close the Page Setup window.

5. From the File menu, select Print. You see a window like this one:

6. Select Stylus Photo R220 from the Printer pop-up menu.

7. Select Print Settings from the pop-up menu.

Select Stylus 
Photo R220

Select your Paper Size

Select your document 
or image orientation

Select Print Settings

Select Stylus 
Photo R220
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14 Printing From Start to Finish

8. Select the following Print Settings as necessary:

9. You can also choose other print settings by selecting these options in the
pop-up menu:

■ Copies & Pages: To select the number of copies or a page range.

■ Layout: To select page layout options.

■ Output Options: To save your print job as a PDF file.

■ Scheduler: To schedule your print job to print at a later time.

■ Paper Handling: To select page printing options, such as Reverse
print order.

■ Cover Page: To print a cover page before your document or photo.

■ ColorSync or Color Management: To select ColorSync® or adjust the 
color controls or gamma setting, or turn off color adjustments made by 
the printer driver.

■ Expansion: To adjust the borderless image size; see page 20 for details.

■ Summary: To view a list of all your selections.

Select the type of 
paper you’re using

Select Color or 
Black ink

Select higher 
quality or faster 
printing (if available)

Click Print

R220.book  Page 14  Sunday, August 7, 2005  3:41 PM



Printing With a Macintosh 15

■ Extension Setting: To select a wider platen gap if ink smears on sheets 
or envelopes.

■ Save Custom Settings: To save your selections for future use. (In OS X 
10.2.4, select Save As from the Presets pop-up menu.)

Note: 

For more information about printer settings, click the ? button.

10. Click the Advanced button to change these settings:

11. Click Print to start printing.

12. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop.

If you’re using Mac OS X 10.2.4, click the  Print Center icon instead, then 
double-click Stylus Photo R220 in the Printer List window.

Select Photo RPM 
for the best print 
quality on certain 
paper types
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16 Printing From Start to Finish

You see a screen like this:

Tip: 

You can also cancel printing by pressing the ) paper button on your printer.

13. When you’re finished, close the printer window or Print Center.

Select the 
print job

Cancel printing

Pause printing Resume printing
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Selecting the Correct Paper Type 17

Selecting the Correct Paper Type

Select the correct paper Type or Media Type setting so your printer knows what 
kind of paper you’re using and adjusts the ink coverage accordingly.

For this paper

Select this paper Type or Media 

Type setting

Plain paper

Epson Iron-On Transfer Paper

Epson Ink Jet Transparencies

Plain Paper

Epson Premium Bright White Paper Bright White Paper

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Ink Jet Cards

Epson Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

Epson Matte Paper Heavyweight

Epson Double-Sided Matte Paper

PremierArt Matte Scrapbook Photo Paper 
for Epson

Matte Paper - Heavyweight

Epson Glossy Photo Paper

Epson ColorLife Photo Paper

Epson Glossy Photo Greeting Cards

Glossy Photo Paper

Epson Ultra Premium Glossy Photo Paper Ultra Premium Glossy Photo Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Premium Luster Photo Paper Premium Luster Photo Paper

Epson Premium Semigloss Photo Paper

Epson Semigloss Scrapbook Photo Paper

Premium Semigloss Photo Paper

Epson Photo Stickers® Photo Stickers

CDs or DVDs CD/DVD

Premium Surface CDs or DVDs CD/DVD Premium Surface

Envelopes Envelope
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18 Printing From Start to Finish

Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page.

Although borderless printing is a bit slower, you get beautiful snapshots and 
enlargements, without trimming, on these papers and sizes:

Return any unused paper to its original package. Store your printouts in resealable 
plastic bags, photo albums, or glass-covered picture frames. Keep both printed and 
unused paper away from high temperatures, humidity, and sunlight.

Paper name Sizes

Paper Type or Media Type 

setting

Epson Matte Paper 
Heavyweight

8 × 10 inches

Letter (8.5 × 11 inches)

Matte Paper - Heavyweight

PremierArt Matte 
Scrapbook Photo Paper

Letter (8.5 × 11 inches) Matte Paper - Heavyweight

Epson Glossy Photo 
Paper

4 × 6 inches

Letter (8.5 × 11 inches)

Glossy Photo Paper

Epson ColorLife Photo 
Paper

Letter (8.5 × 11 inches) Glossy Photo Paper

Epson Ultra Premium 
Glossy Photo Paper

4 × 6 inches

Letter (8.5 × 11 inches)

Ultra Premium Glossy Photo 
Paper

Epson Premium Glossy 
Photo Paper

4 × 6 inches

5 × 7 inches

8 × 10 inches

Letter (8.5 × 11 inches)

Premium Glossy Photo Paper

Epson Premium Luster 
Photo Paper

Letter (8.5 × 11 inches) Premium Luster Photo Paper

Epson Premium 
Semigloss Photo Paper

Letter (8.5 × 11 inches) Premium Semigloss Photo 
Paper

Epson Semigloss 
Scrapbook Photo Paper

Letter (8.5 × 11 inches) Premium Semigloss Photo 
Paper
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Printing Borderless Photos 19

See these sections for instructions on selecting printer settings:

■ “Windows” below

■ “Macintosh” on page 20

Windows

1. Start your photo program and open your photo.

2. From the File menu, select Print. 

3. Make sure EPSON Stylus Photo R220 Series is selected, then click 
Properties or Preferences.

You see the following window:

4. Select Photo or Best Photo as the Quality Option setting.

5. Select one of the following as the paper Type setting:

■ Matte Paper - Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Ultra Premium Glossy Photo Paper

■ Premium Glossy Photo Paper

Select Photo 
or Best Photo

Click here for 
more settings

Click here for 
photos without 
white borders
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20 Printing From Start to Finish

■ Premium Luster Photo Paper

■ Premium Semigloss Photo Paper

6. Click the Borderless checkbox. Read the message and click OK.

Note: 

If you need to adjust the amount of image expansion necessary for borderless 
printing, click the Page Layout tab and move the Expansion slider.

7. Select your paper Size setting.

8. Select your photo orientation.

9. Click OK to save your settings, then click OK or Print to start printing.

Macintosh

1. Start your photo program and open your photo.

2. From the File menu, select Page Setup. You see the Page Setup window:

3. Select Stylus Photo R220 from the Format for pop-up menu.

4. Select a borderless Paper Size.

5. Select your photo orientation.

6. Click OK to close the Page Setup window.

Select Stylus Photo R220
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Printing Borderless Photos 21

7. From the File menu, select Print.

8. Select Stylus Photo R220 in the Printer pop-up menu.

9. Select Print Settings from the pop-up menu.

10. Select one of the following as the Media Type setting:

■ Matte Paper - Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Ultra Premium Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Luster Photo Paper

■ Premium Semigloss Photo Paper

11. Select Quality using the slider.

Note: 

If you need to adjust the amount of image expansion necessary for borderless 
printing, select Expansion from the pop-up menu and move the Expansion slider.

12. Click Print to start printing.

Select Stylus Photo R220

Select Print Settings
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22 Printing From Start to Finish

Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics, 
and photos directly on any ink jet-printable CD or DVD. The EPSON Print CD 
software makes it easy to import your own photos, add text, and modify your 
designs with a variety of special effects. You can print on both regular 12-cm and
8-cm mini CDs and DVDs.

Caution: 

Use only ink jet-printable CDs and DVDs for printing. Thermal-printable and regular CDs 
and DVDs should not be used with this printer.

Follow the steps in these sections to print on CDs or DVDs:

■ “Cleaning the Rollers” below

■ “Inserting a CD or DVD” on page 23

■ “Designing CDs and DVDs”

■ “Printing Your Design” on page 27

■ “Adjusting the Print Position” on page 28

■ “Adjusting the Print Density” on page 29

Cleaning the Rollers

Before you print on CDs or DVDs, it’s a good idea to clean the rollers inside your 
printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure your printer is turned on and several sheets of letter-size paper
are loaded.

2. Press the ) paper button to feed a sheet of paper into the printer.

3. Press the ) paper button again to eject the paper.

4. Repeat steps 2 and 3 several times.
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Printing on CDs and DVDs 23

Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or 
DVDs before you print. Otherwise, dirt or scratches on the surface may cause 
errors when you burn the data. If you plan to print a large number of CDs or 
DVDs, it’s a good idea to print a small sample, then wait a day and check the 
quality to make sure it’s satisfactory.

If you want to check the print position, or color, see the instructions for 
“Adjusting the Print Position” on page 28 and “Adjusting the Print Density” on 
page 29.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, 
the disc may not be positioned correctly. Then follow these steps:

1. Push in the output tray extension, but leave the tray open. 

2. Open the printer cover and pull down the CD/DVD tray guide.
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3. Place the CD or DVD on the CD/DVD tray with the white or printable side 
face-up. Make sure the disc lays flat in the tray.

To print on a small CD (8-cm), place the small CD ring on the tray first, then 
place the CD inside the ring.

Caution: 

Make sure you always use the small CD ring when printing on 8-cm CDs and that 
the CD and ring lay flat on the tray, otherwise the printer may be damaged.

4. Insert the tray carefully, making sure it’s level, not tilted up or down. Push the 
tray under the tab and the two rollers. Don’t push the tray in too far and make 
sure that the arrows line up exactly.

5. Follow the instructions in “Printing Your Design” on page 27 to print with 
EPSON Print CD.

Always use this 
piece with 8 cm CDs
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Designing CDs and DVDs

You can use EPSON Print CD to create and print a disc design with images, 
graphics, and text.

1. Start EPSON Print CD by doing one of the following:

■ Windows: Click Start > Programs or All Programs > EPSON Print 
CD > EPSON Print CD.

■ Macintosh: Open the Applications > EPSON Print CD folder and select 
EPSON Print CD.

2. To add a background image, click the  or  background icon. You see the 
following window:

3. To select a background image do one of the following:

■ Windows: Click the File tab, then click Browse to locate the folder your 
images are stored in and click OK. You see thumbnail images of all the 
files in the folder. Select your image and click OK.

■ Macintosh: Click Select Background, locate the folder your images are 
stored in, select the one you want, then click Open.

Note: 

In Windows, if you have already chosen a background, you see a different screen. 
Click Select Image to choose a new background.

Windows

Macintosh
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4. To add text, do one of the following:

■ Windows: Click the  button. Enter your text and use the tabs to apply 
formatting and special effects, and click OK. (To open the window again, 
double-click any block of text.)

■ Macintosh: Click the  button. In the Text Settings window, type your 
text, then use any of the options in the window to format it. You can also 
use options in the Color Settings and Object Settings windows.

5. To curve a single line of text, click the text in the main window, then drag the 
red “handle” up or down. Then adjust it using the other handles that appear.

6. When you’re finished, choose Save as from the File menu to save your file.

Note: 

To check your design, it’s a good idea to print it on a sheet of plain paper before 
printing on a CD or DVD. Make sure you have plain paper loaded in the printer, then 
follow the instructions in “Printing Your Design” on page 27.

Windows Macintosh
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Printing Your Design

After you have created your design and loaded a CD or DVD, you’re ready
to print.

1. Open the File menu and select Print.

2. Make sure EPSON Stylus Photo R220 Series (Windows) or Stylus Photo 
R220 (Macintosh) is selected, then click Print.

Note: 

After you print, handle the CD or DVD carefully. To allow the ink to dry, wait at least 24 
hours before playing the disc or inserting it in a drive. Keep printed discs away from 
moisture and direct sunlight.

If you need to adjust the print position or color, see “Adjusting the Print Position” 
on page 28 or “Adjusting the Print Density” on page 29.

Windows Macintosh
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Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want, 
you may need to adjust the printing position. Use the blank cardboard check disk 
included with your printer, or an extra CD. You can also use these steps to check 
the position before you print on a CD or DVD.

1. Place the cardboard check disk (or an extra CD) on the CD tray and insert it 
into the printer, as described on page 23.

2. Start EPSON Print CD.

3. Select Print from the File menu.

4. Make sure EPSON Stylus Photo R220 Series (Windows) or Stylus Photo 
R220 (Macintosh) is selected, then click Print Position Confirmation 
Pattern (Windows) or Print Position Check Pattern (Macintosh).

5. Click Print. The confirmation pattern is printed on the check disk or CD.

6. Remove the check disk or CD and measure the distance from the edge of the 
hole to the small cross marks labeled A and B. You’ll need a metric ruler with 
millimeters for accurate measurements.

Windows Macintosh
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7. Open the File menu and select Adjust Print Position (Windows) or Position 
Adjustment (Macintosh). You see a screen like this:

8. Make sure Enter Values (Windows) or Value Entry (Macintosh) is checked. 
Input the A distance in the Height (Top) or Top Space box. Enter the B 
distance in the Width (Right) or Right Space box.

9. Click OK to save the measurements.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color 
saturation or ink density. CDs from different manufacturers may absorb ink 
differently, so you may need to adjust the density for each type of disc. Follow 
these instructions to print a color saturation check pattern, and then make 
adjustments as necessary.

1. Insert a test CD or DVD for printing, as described on page 23.

2. Start EPSON Print CD.

3. Select Print from the File menu.

4. Make sure EPSON Stylus Photo R220 Series (Windows) or Stylus Photo 
R220 (Macintosh) is selected, then click Print Density Confirmation 
Pattern (Windows) or Print Density Check Pattern (Macintosh).

5. Click Print.

Windows Macintosh
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6. After the pattern is printed, examine the print and make the Print Color 
Correction (Windows) or Color Correction (Macintosh) setting lighter or 
darker as necessary.

You can print three density patterns on one disc. Each pattern is printed in a 
different location.

7. After the first pattern is printed, adjust the setting, then repeat steps 4 through 
6, selecting Second or Second Time to print the second pattern.

8. If you want to try a third Color Correction setting, you can repeat steps 4 
through 6 again and select Third or Third Time.

9. Remove the CD or DVD and let it dry for at least 24 hours. Then check the 
saturation levels again.

You can also use the Brightness and Contrast settings in EPSON Print CD to 
adjust color saturation. See the EPSON Print CD on-screen help for instructions.
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Cleaning the Print Head

If your printouts are unexpectedly light or dots or lines are missing, you may need 
to clean the print head. This unclogs the nozzles so they can deliver ink properly. 
Print head cleaning uses ink, so clean it only if quality declines.

This section explains how to clean the print head using the Head Cleaning Utility. 

You can also clean the print head by holding down the H ink button on the printer 
for three seconds. (This only works when the red H ink light is off.)

Caution: 

When you don’t turn on your printer for a long time, print quality can decline, so turn it 
on and print a few pages at least once a month to maintain good print quality.

Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red H ink light is 
off. (If the H ink light is flashing or on, you need to replace a cartridge; see 
page 33 for details.)

2. Do one of the following:

■ Windows: Right-click the  icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

■ Macintosh: Open the Applications folder and select EPSON Printer 
Utility. Select SP R220 Series in the printer list, click OK, then select 
Head Cleaning.

3. Follow the instructions on the screen to clean the print head.

Cleaning takes about 45 seconds. The printer makes noise and the green
P power light flashes.

Caution: 

Never turn off the printer while the green P power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.
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4. When the green P power light stops flashing, make sure paper is loaded in the 
printer, then do one of the following:

■ Windows: Click Print nozzle check pattern, then click Print.

■ Macintosh: Click Confirmation, then click Next.

The nozzle check pattern prints.

5. If the nozzle check pattern has no white lines or gaps (as shown below),
click Finish.

If the pattern has white lines or gaps (as shown below), click Clean to clean 
the print head again.

If you don’t see any improvement after cleaning three or four times, refer to 
“Problems and Solutions” on page 46.

You can also turn the printer off and wait overnight—this allows any dried ink 
to soften—and then try cleaning the print head again.

R220.book  Page 32  Sunday, August 7, 2005  3:41 PM



Replacing an Ink Cartridge 33

Replacing an Ink Cartridge

When the red H ink light flashes, one or more ink cartridges are low on ink.

When the red H ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which 
cartridge is low or empty.

When a cartridge is more than six months old, you may need to replace it if 
printouts don’t look their best. If the quality doesn’t improve after cleaning and 
aligning the print head, you can replace the cartridge even if the red H ink light
is off.

Checking the Ink Supply

To check the ink supply, do one of the following:

■ Windows: Double-click the  icon on the Windows taskbar.

You see a window like this one:

Ink button and light
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34 Maintaining Your Printer

■ Macintosh: Open the Applications folder and select EPSON Printer Utility. 
Select SP R220 Series in the printer list, click OK, then select EPSON 
StatusMonitor.

You see a window like this one:

Click a cartridge image to display information about the cartridge.
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Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package:

Caution: 

To ensure good results, use genuine Epson ink cartridges and do not refill them. Other 
products may cause damage to your printer not covered by Epson’s warranty.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. 
To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To 
purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please 
call 800-463-7766 for reseller referral.

Ink Cartridge Precautions

Warning: 

Keep ink cartridges out of the reach of children and don’t drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your 
eyes, flush them thoroughly with water.

Caution: 

To avoid damaging the printer, never move the print head by hand.

You cannot print if an ink cartridge is empty. Leave the empty cartridge installed in the 
printer until you have obtained a replacement. Otherwise the ink remaining in the print 
head nozzles may dry out.

Ink cartridge Part Number

Black T048120

Cyan T048220

Magenta T048320

Yellow T048420

Light Cyan T048520

Light Magenta T048620

Color Multipack T048920
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

1. Make sure the printer is turned on (the green P power light should be on, but 
not flashing). Then open the printer cover.

2. Press and release the H ink button.

If your ink light is off, go to step 4.

If your ink light is on or flashing, the print head moves to the left, and the 
cartridge that need to be replaced stops under the _ ink out mark. The
P power light begins to flash. Go to step 3.

3. Press the H ink button again.

■ If more than one cartridge is empty, the next cartridge moves under the 
_ ink out mark.

■ If all the empty cartridges have been identified, the print head moves to 
the ink cartridge replacement position.

Note: 

You can also use the Status Monitor to find out which cartridge is out of ink. See 
“Checking the Ink Supply” on page 33 for more information.

4. Lift up the cartridge cover. 
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5. Press in the tab on the back of the cartridge and lift the cartridge out of the 
printer. Dispose of it carefully.

Warning: 

Keep ink cartridges out of the reach of children and don’t drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in 
your eyes, flush them thoroughly with water.

6. Unwrap the new ink cartridge.

Caution: 

Don’t touch the green circuit board or remove any labels.

7. Lower the cartridge into the holder, with the green circuit board facing the 
front. Then gently push the cartridge down until it clicks into place. 

Don’t touch the 
green circuit board
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8. If you need to replace another ink cartridge, repeat steps 5 through 7 before 
continuing with step 9.

9. Close the cartridge cover.

10. Close the printer cover and press the H ink button. The printer begins 
charging the ink delivery system. 

The green P power light flashes and the printer makes noise. Charging takes 
about half a minute. When it’s finished, the green P power light stops 
flashing and stays on, and the red H ink light goes out.

Caution: 

Never turn off the printer while the green P power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 mintues.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark 
horizontal banding, you may need to align the print head.

1. Turn on the printer.

2. Load several sheets of plain, letter-size paper.

3. Do one of the following:

■ Windows: Right-click the  icon on your taskbar (in the lower right 
corner of your screen). Select Print Head Alignment.

■ Macintosh: Open the Applications folder and select EPSON Printer 
Utility. Select SP R220 Series in the printer list, click OK, then select 
Print Head Alignment.

4. Follow the instructions on the screen to print the alignment pattern.

You see a window like this one:

5. On the test page, select the square without any visible bands. You may need to 
use a magnifying glass or loupe.

R220.book  Page 39  Sunday, August 7, 2005  3:41 PM



40 Maintaining Your Printer

6. Select one square each for rows 1 to 4, then enter the number of the best 
square in the corresponding boxes on the screen. Then click Next.

If you can’t find a square without visible bands, choose the one that’s best. 
Then click Realignment to print another test page and repeat this step.

7. After you click Next, follow the instructions on the screen to print the next 
test page. 

You see a window like this one:

8. On the test page, select the square without any visible bands. You may need to 
use a magnifying glass or loupe.

9. Select one square each for rows 1 to 4, then enter the number of the best 
square in the corresponding boxes on the screen. Then click Finish.

If you can’t find a square without visible bands, choose the one that’s best. 
Then click Realignment to print another test page and repeat this step.
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the USB cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the outer case or inside of the sheet feeder are dirty, clean it with a soft cloth 
dampened with mild detergent. Keep the printer cover closed to prevent water 
from getting inside.

4. If ink accidentally gets inside of the printer, wipe it off with a damp cloth in 
the area shown.

Warning: 

Don’t touch the gears or any other parts inside the printer.

Caution: 

Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner for 
cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils inside 
the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside the 
printer.

Clean here
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Transporting the Printer

If you need to move your printer some distance, you must prepare it for 
transportation in its original box or one of a similar size.

Caution: 

To avoid damage, always leave the ink cartridges installed when transporting
the printer.

1. Open the printer cover and turn on the printer. Wait until the print head 
locks in the far right position, then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the power 
cord and USB cable from the printer.

3. Remove any paper from the printer, then push down the paper support 
extension, and close the paper support.

4. Make sure the CD/DVD tray guide is closed, then push in the output tray 
extension and close the tray.

5. Open the printer cover. Secure the ink cartridge holder to the printer with 
tape, then close the printer cover.

6. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test 
your printer. If you notice a decline in print quality, clean the print head
(see page 31); if output is misaligned, align the print head (see page 39).
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Solving Problems

See “Diagnosing Printer Problems” on page 44 to help determine what the cause 
of your printer problem may be. If you cannot solve the problem, see “Where To 
Get Help” on page 54.

Printer Parts

Paper support 
extension

Sheet feeder

Edge guide

Front USB port

Output tray 

Output tray 
extension

Ink button 
and light

Power button 
and lightPaper support

Paper button 
and light

Power connector

Rear USB port
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Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 63).

Lights Explanation

Green P power light 
flashes

The printer is receiving a print job, replacing an ink 
cartridge, charging ink, or cleaning the print head.

Red ) paper light is 
on

If the CD/DVD tray guide is open, close the CD/DVD tray 
guide, load paper, then press the ) paper button.

Your paper ran out or multiple sheets loaded at the same 
time. Load paper and press the ) paper button to resume 
printing.

When printing on CDs or DVDs, the CD/DVD tray is not 
inserted in the printer. Insert the CD/DVD tray into the 
printer and press the ) paper button to print (see 
“Inserting a CD or DVD” on page 23).

Red ) paper light 
flashes

Paper is jammed in the printer. Press the ) paper button 
to eject the jammed paper. If the light is still flashing, open 
the cover and remove all paper, including any jammed or 
torn pieces. Then reload paper and press the ) paper 
button to continue printing.

When printing on CDs or DVDs, the CD/DVD tray is 
jammed in the printer. Pull out the CD/DVD tray and press 
the ) paper button.

Red H ink light flashes One or more cartridges are low on ink. Check the 
message that appears on your screen to determine which 
cartridge is low, or follow the instructions in “Checking 
the Ink Supply” on page 33. Make sure you have a 
replacement cartridge.

Red H ink light is on One or more cartridges are out of ink or not installed. 
Make sure you have a replacement cartridge, then follow 
the steps in “Replacing an Ink Cartridge” on page 33.

If you have just installed a new cartridge, it may be 
incompatible with the printer or incorrectly installed. 
Reinstall it or replace it with the correct cartridge as 
described on page 33.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the 
printer or some other source.

1. Turn off your printer and computer. 

2. Disconnect the printer’s USB cable. 

3. Load letter-size paper in the printer.

4. Hold down the ) paper button, then press and release the P power button. 
When printing starts, release the ) paper button.

Red H ink and red 
) paper lights flash 
alternately

The CD/DVD tray guide was left open when you turned on 
the printer or when printing on paper. Close the CD/DVD 
tray guide.

Green P power light is 
off; red ) paper and 
red H ink lights flashing

Paper may be blocking movement of the print head. Turn 
off the printer, then open the cover and remove any 
jammed paper or other foreign objects. Turn the printer 
back on again. If the lights are still flashing, contact Epson 
as described on page 54.

The printer may have an internal error. Turn off the printer, 
wait a few seconds, then turn it on again. If the lights are 
still flashing, contact Epson as described on page 54.

Lights Explanation
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5. A nozzle check pattern prints. (If the pattern has gaps, you need to clean the 
print head as described on page 31.)

■ If the test page prints, the problem probably lies in your software settings, 
USB cable, or computer, or your software may not be installed correctly.

■ If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” below. If nothing works, 
contact Epson as described in “Where To Get Help” on page 54.

6. Turn off the printer, reconnect the USB cable, then turn on your printer and 
computer.

Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the printer must charge its print head 
for about two minutes. Wait until charging finishes before you turn off the 
printer, or it may charge improperly and use excess ink the next time you turn 
it on. 

■ Make sure the ink cartridge cover is closed completely and no packing 
material remains in the printer. Turn off the printer, wait a moment, then turn 
it back on to clear the error.

You’re having problems installing the printer software.

■ Carefully follow the installation instructions on the Start Here sheet. Do not 
connect your printer to the computer until you are instructed to do so. When 
connecting your printer, make sure the USB cable is connected securely to the 
printer and the computer. Also make sure your system meets the requirements 
shown on page 57.

■ Close your other programs, including any screen savers and virus protection 
software, and install again.
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■ If you are using a Macintosh and you do not see the printer name in the 
Format for menu on the Page Setup screen, you may need to set up your 
printer in the Printer Setup Utility or Printer Center. See the Start Here sheet 
for instructions. 

■ For Windows 2000, if you see an error message or your software doesn’t install 
correctly, you may not have software installation privileges. Contact your 
System Administrator.

■ Make sure Windows 98SE, Me, 2000, or XP was preinstalled on your system. 
The USB Printer Device Driver may not install correctly if you’ve upgraded 
from Windows 95.

■ Make sure the USB Controller is working properly in Device Manager. See 
your Windows help system for details. If it’s not working, contact your 
computer manufacturer.

■ If you’re printing over a network, see your on-screen Reference Guide for 
instructions on configuring your printer for use on a network.

Printer Problems

The printer is on, but nothing prints.

■ Make sure the USB cable is connected securely and that the cable meets the 
system requirements on page 57.

■ Run a printer check as described on page 45. If the check page prints, make 
sure your software is installed correctly. 

■ If you’re printing on a network, you need to set up your printer for network 
printing, as described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see 
page 31.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.
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Your printer makes noise when you turn it on or after it has been sitting for 
awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the requirements listed on page 57. If you’re printing 
a high-resolution image, you need more than the minimum requirements listed. 
You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close open programs that you’re not using.

■ Increase your system’s memory (RAM).

For the fastest printing, try these tips:

■ Set the Quality Option to Draft (Windows) or the Quality/Speed slider to 
Speed (Macintosh).

■ In the Advanced options, turn MicroWeave® off (Macintosh only) and turn 
High Speed on.

■ If your printer is connected to a hub, disconnect USB devices that you’re not 
using.

Note: 

Borderless printing takes longer, especially near the edges of the paper.

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning; 
see page 31 for instructions. 

■ Select a higher print quality and turn off 
High Speed mode. see page 10 (Windows) 
or page 14 (Macintosh) for instructions.

■ Make sure the Type (Windows) or Media Type (Macintosh) setting matches 
the paper you loaded; see page 17 for guidelines.
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■ Make sure the printable side of the paper is face up. It’s usually brighter or 
whiter.

■ The ink cartridges may need replacing; see page 33 for instructions.

■ Run the Print Head Alignment utility; see page 39 for instructions. 

Your printout is blurry or smeared.

■ Make sure you load paper with the printable 
side face up. The printable side is usually the 
brighter or whiter side of the paper. 

■ Make sure your paper isn’t damp or curled, 
or loaded face down (the printable side 
should be face up). If it’s damp or curled, 
reload a new stack of paper.

■ When printing on special paper, check the instructions in the paper package. 
You may need to use an included support sheet or load your paper one sheet at 
a time.

■ Use Epson papers to ensure proper saturation and absorption of genuine 
Epson inks. 

■ Make sure your paper meets the specifications listed in the on-screen Reference 
Guide. 

■ Run the Print Head Alignment utility; see page 39 for instructions.

■ Remove each sheet from the output tray after printing, especially when you’re 
printing on transparencies.

Your printout is faint or has gaps.

■ The print head nozzles may need cleaning; 
see page 31 for instructions. 

■ The ink cartridges may be old or low on ink. 
To replace an ink cartridge, see page 33. 

■ Make sure the paper Type (Windows) Media 
Type (Macintosh) setting matches the paper 
you loaded; see page 17 for guidelines.
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■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, 
reload a new stack of paper with the printable side up; it is usually brighter or 
whiter than the other side.

Your printout is grainy.

■ Try using a higher quality paper.

■ Select a higher print quality setting; see page 10 (Windows) or page 14 
(Macintosh) for instructions.

■ Run the Print Head Alignment utility. See page 39 for instructions.

■ You may need to increase the image resolution or print it in a smaller size; see 
your software documentation.

You see wrong or missing colors.

■ Make sure Black ink only (Windows) is off or Color ink is selected 
(Macintosh) even when printing black and white photographs.

■ Clean the print head; see page 31 for instructions.

■ The ink cartridges may be old or low on ink; see page 33.

■ Try turning off PhotoEnhance.™ Also check if you’re using a special effect that 
alters image colors, like Sepia. 

■ Try changing the Gamma setting; see your on-screen Reference Guide for 
more information.

■ Your printed colors can never exactly match your on-screen colors. However, 
you can use a color management system to get as close as possible. You can 
also use your printer’s color management features. See your on-screen 
Reference Guide for more information.

■ Colors will change slightly after drying. Wait for 24 hours and check your 
print again to see if the colors look right.

Problems With Paper Feeding

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
) paper button to eject the paper, then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin.

R220.book  Page 50  Sunday, August 7, 2005  3:41 PM



Problems and Solutions 51

Paper doesn’t feed correctly or jams in the printer.

■ Make sure the paper support extension is pulled up. 

■ If paper doesn’t feed, remove it from the sheet feeder, reload it against the right 
edge, then slide the left edge guide against the paper.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, and carefully reload it.

■ If paper jams, press the ) paper button to clear the jam. If that doesn’t resolve 
the paper jam, open the cover and remove any jammed paper, including small 
pieces that may have torn off. Reload the paper and press the ) paper button.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up. Don’t load 
paper above the arrow mark on the left edge guide.

■ Place the paper against the right edge and slide the left edge guide against it, 
but not too tight.

■ Store paper flat to prevent curling.

CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.

Adjust the Print position as described on page 28.

Ink smears on the CD/DVD or printing is too light.

■ Make sure you’re using ink jet-printable CDs or DVDs.

■ Handle the disc carefully and allow the ink to dry for at least 24 hours before 
playing the disc or inserting it in a drive.

■ Adjust the print density as described on page 29.

■ Adjust the brightness or contrast. See the EPSON Print CD on-screen Help.

Printed CDs or DVDs are dirty.

Clean the rollers as described on page 22.
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The CD/DVD won’t feed into the printer.

Make sure you hold the CD/DVD tray level as you load it into the tray guide 
without tilting it up or down. Don’t push in the tray too far, but line it up with the 
arrows exactly as described on page page 23.

Miscellaneous Printout Problems

The image is inverted.

Turn off the Mirror Image setting in the Advanced window or the mirror setting 
in your program. (If you’re printing on Epson Iron-On Transfer Paper, the image 
should be inverted.)

The printer prints blank pages.

■ Make sure your printer is selected, or is the active printer in the Printer Setup 
Utility or Print Center (Macintosh).

■ The print head nozzles may need cleaning; see page 31. 

The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. 

■ Make sure the paper is positioned all the way to the right of the sheet feeder. 
Slide the left edge guide against the paper. 

■ See your software documentation for instructions on choosing the correct 
margins for your paper size. The margins must be within the printable area of 
the page. See “Printer Specifications” in your on-screen Reference Guide.

Image size or position is incorrect.

■ Make sure the paper and layout options are set correctly.

■ Your images may not match the width/height proportions of the paper size or 
layout you’re using, and may be cropped to fit.
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You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the system 
requirements on page 57. Then try printing again.

■ Make sure your printer is selected in your software, or is set as the active 
printer in the Printer Setup Utility or Print Center (Macintosh).

■ If you’re using a USB hub, connect the printer directly to your computer 
instead.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for 
multiple copies.

Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For 
example, this might be necessary when you upgrade your operating system. You 
don’t need to uninstall EPSON Print CD or your on-screen Reference Guide.

Note: 

Do not turn off or disconnect the printer while you are uninstalling the software.

Windows

1. Double-click the My Computer icon on your desktop. (If you’re using 
Windows XP click Start, then click My Computer.)

2. Select the Control Panel icon.

3. Select Add/Remove Programs.

4. Click EPSON Printer Software in the program list and click the
Add/Remove button (Change/Remove button on Windows 2000 and XP).

5. Select EPSON Stylus Photo R220 Series, then click OK. 

6. Follow the on-screen instructions to uninstall the printer software.

7. If you’re using Windows 98 or Me, select EPSON USB Printer Devices in 
the program list, then click the Add/Remove button.

8. Restart your computer, then see the Start Here sheet to reinstall your software.
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Macintosh

1. Open your Applications folder, then open the Utilities folder. 

2. Double-click the Print Center or Printer Setup Utility icon.

3. Select EPSON Stylus Photo R220, then click Delete. 

4. Close Print Center or the Printer Setup Utility. 

5. Restart your Macintosh, then see the Start Here sheet to reinstall your 
software.

Where To Get Help

Epson provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday, 
and 7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through 
Friday.

Toll or long distance charges may apply.

Service Access

World Wide Web From the Internet, you can reach Epson Support at 
http://support.epson.com. At this site, you can 
download drivers and other files, look at product 
documentation, access troubleshooting information, 
and receive technical advice through e-mail.

Automated Telephone 
Services

A variety of automated help services are available 24 
hours a day, seven days a week. To use these 
services, you must have a touch tone telephone and 
call (800) 922-8911. Your Epson SoundAdviceSM code 
is 82700. Use this code to quickly select the Epson 
Stylus Photo R220 Series printer in SoundAdvice.
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Please have the following information ready:

■ Product name (Epson Stylus Photo R220)

■ Product serial number (located on the back of the printer and on its box)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. 
To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To 
purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please 
call 800-463-7766 for reseller referral.
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Windows System Requirements

To use your printer and its software, your system should have:

■ A Microsoft® Windows compatible PC with a Pentium® 300 MHz or faster.

■ Microsoft Windows 98SE, Windows Me, Windows 2000, or Windows XP

■ At least 256MB RAM (512MB recommended)

■ 200MB free hard disk space (300MB or more recommended)

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ A Windows-compliant USB port

■ A shielded USB “AB” cable up to 6.5 feet (2 meters) long

Macintosh System Requirements

To use your printer and its software, your system should have:

■ An Apple® iMac™ series, eMac,™ Power Macintosh® G3, G4, or G5, 
PowerBook,® or iBook® with a built-in USB port

■ Macintosh OS X 10.2.4 or later (Macintosh OS X 10.2.4 or later 
recommended)

■ At least 256MB RAM (512MB Recommended)

■ At least 200MB free hard disk space (300MB or more recommended)

■ VGA or better display

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable up to 6.5 feet (2 meters) long
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the 
printer safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets 
on the same circuit as photocopiers or air control systems that regularly switch on
and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée 
facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices plugged into the wall outlet does 
not exceed the wall outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of 
electromagnetic interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all 
directions. The printer will not operate properly if it is tilted or at an angle.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do 
not spill liquid on the printer.

■ Always turn the printer off using the P power button. It may take a moment for the 
printer to shut off after you press the button. Don’t switch off the power strip or 
unplug the printer until the printer is off.

■ Do not block or cover the openings in the printer’s case or insert objects through
the slots. 

■ Except as specifically explained in this manual, do not attempt to service the
printer yourself. 
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■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions:
If the power cord or plug is damaged; if liquid has entered the printer; if the printer 
has been dropped or the case damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those controls that are covered 
by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and don’t drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around 
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets 
in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the 
cartridge unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the package. For best results, 
use up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

■ Do not shake an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the
print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal 
operation and printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust and store it in the same environment as the printer. Note that there is a valve in 
the ink supply port, making covers or plugs unnecessary, but care is needed to prevent 
the ink from staining items that the cartridge touches. Do not touch the ink cartridge 
ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right 
position and the ink cartridges are in place. Tape the ink cartridge holder to the 
printer case to make sure it remains in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this 
equipment will invalidate the FCC Certification of this device and may cause interference 
levels which exceed the limits established by the FCC for this equipment. It is the 
responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables 
connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/
or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR 
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is 
identical to the representative unit tested and found to be compliant with the standards. 
Records maintained continue to reflect the equipment being produced can be expected to 
be within the variation accepted, due to quantity production and testing on a statistical 
basis as required by 47CFR §2.909. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B261A

ENERGY STAR Compliance

As an ENERGY STAR® Partner, Epson has determined that 
this product meets the ENERGY STAR guidelines for 
energy efficiency. The EPA ENERGY STAR office 
equipment program is a voluntary partnership with the 
computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, 
monitors, printers, fax machines, and copiers in an effort 
to reduce air pollution caused by power generation.
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser 
that the EPSON printer covered by this limited warranty statement, if purchased and 
operated only in the United States or Canada, conforms to the manufacturer’s 
specifications and will be free from defects in workmanship and materials for a period of 
one (1) year from the date of original purchase. Epson also warrants that the consumable 
ink cartridges enclosed with the printer will perform to the manufacturer’s specified usage, 
which usage may expire before the expiration of the limited warranty for the EPSON 
printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective 
during the warranty period, please call the EPSON ConnectionSM at (562) 276-7296 
(U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return 
authorization. An Epson service technician will provide telephone diagnostic service to 
determine whether the printer requires service. If service is needed, Epson will, at its 
option, exchange or repair the printer without charge for parts or labor. If Epson 
authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto 
Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You 
are responsible for securely packaging the defective unit and returning it to Epson within 
five (5) working days of receipt of the replacement. Epson requires a debit or a credit card 
number to secure the cost of the replacement printer in the event that you fail to return the 
defective one. If your printer is being repaired, Epson will direct you to send your printer 
to Epson or its authorized service center, where the printer will be fixed and sent back to 
you. You are responsible for packing the printer and for all costs to and from the Epson 
authorized service center. When warranty service involves the exchange of the printer or a 
part, the item replaced becomes Epson property. The replacement printer or part may be 
new or refurbished to the Epson standard of quality, and, at Epson’s option, may be 
another model of like kind and quality. Epson’s liability for replacement of the covered 
printer will not exceed the original retail selling price of the covered printer. Exchange 
products and parts assume the remaining warranty period of your original product covered 
by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or 
reconditioned products. This warranty covers only normal use in the United States and 
Canada. Using this product for continuous production or similar high duty purposes is 
not considered normal use; damage, maintenance or service from such use will not be 
covered under this warranty. This warranty is not transferable. This warranty does not 
cover any color change or fading of prints or reimbursement of materials or services 
required for reprinting. This warranty does not cover damage to the EPSON product 
caused by parts or supplies not manufactured, distributed or certified by Epson. This 
warranty does not cover ribbons, ink cartridges or third party parts, components, or 
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peripheral devices added to the EPSON product after its shipment from Epson, e.g., 
dealer or user-added boards or components. Epson is not responsible for warranty service 
should the Epson label or logo or the rating label or serial number be removed or should 
the product fail to be properly maintained or fail to function properly as a result of misuse, 
abuse, improper installation, neglect, improper shipping, damage caused by disasters such 
as fire, flood, and lightning, improper electrical current, software problems, interaction 
with non-Epson products, or service other than by an Epson Authorized Servicer. If a 
claimed defect cannot be identified or reproduced, you will be held responsible for the 
costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS 
STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY 
OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS 
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR 
DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY 
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and 
some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitations and exclusions may not apply to you. This warranty 
gives you specific legal rights and you may have other rights which vary from jurisdiction 
to jurisdiction. 

To find the Epson Authorized Reseller nearest you, visit our website at: 
http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://support.epson.com.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
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A
Accessories, 55
Aligning print head, 39 to 40
Automatic mode, Macintosh, 14

B
Banding, 48 to 49
Basic printing

Macintosh, 13 to 16
Windows, 9 to 12

Blank pages, 52
Blurry images, 49
BorderFree printing, 18 to 21

C
Cable, printer, 57
Cancelling printing

Windows, 12
CDs

adjusting print density, 29 to 30
adjusting print position, 28 to 29
designing, 25 to 26
inserting in printer, 23 to 24
printing on, 22 to 30
printing problems, 51 to 52

Characters, incorrect, 53
Checking printer, 45 to 46
Cleaning

print head, 31 to 32
printer, 41
rollers, 22
sheets, 41

Color problems, 50

ColorSync, 14
Controlling printing

Windows, 12
Copies setting, Macintosh, 14

D
Default printer settings, 12
DVDs, see CDs

E
Edge-to-edge printing, 18 to 21
Epson

accessories, 55
help, 54 to 55
ink, 35
papers, 8, 17, 18
Print CD, 27 to 30
Store, 55

F
Faint images, 49 to 50
Full bleed printing, 18 to 21

G
Gamma setting, 14
Glossy Photo Paper, 17
Grainy prints, 50

H
Head Cleaning utility, 31 to 32
Help, Epson, 54 to 55
High Speed setting, 48
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I
Incorrect characters, 53
Incorrect colors, 50
Ink cartridge

level of ink in, 33
ordering, 35
replacing, 33 to 38
safety instructions, 37, 59

Ink Jet Transparencies, 17
Ink level, checking

Macintosh, 34
Windows, 33

Installation problems, 46 to 47
Inverted image, 52
Iron-On Transfer Paper, 17

J
Jams, paper, 51

L
Layout problems, 52
Layout settings

Macintosh, 14
Windows, 11

Luster Photo Paper, 17

M
Macintosh

basic printing, 13 to 16
system requirements, 57
uninstalling software, 54

Maintaining printer, 31 to 42
Marginless printing, 18 to 21
Margins, incorrect, 52
Media Type setting, 17
MicroWeave setting, 48
Mirror image, 52

Monitoring ink level
Macintosh, 34
Windows, 33

Moving printer, 42

N
Noise, printer, 48
Nozzle check, 32

P
Page Setup, Macintosh, 13
Paper

Epson, 8, 17, 18
feeding problems, 50 to 51
loading, 7 to 8
orientation, 10, 13
size, 10, 13

Paper Type setting, 10, 17
Premium Glossy Photo Paper, 17
Print CD software, 27 to 30
Print dialog box

Macintosh, 13
Windows, 9

Print head
aligning, 39 to 40
cleaning, 31 to 32

Print Head Alignment utility, 39 to 40
Print position check paper, 28 to 29
Print quality problems, 48 to 50
Print window, 9, 13
Printer

cable, 57
check, 45 to 46
cleaning, 41
maintaining, 31 to 42
noise, 48
problems, 43 to 53
transporting, 42
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Printing
basic, 9 to 16
BorderFree, 18 to 21
CDs and DVDs, 22 to 30
controlling, 12

Printing, slow, 48
Problems

CD printing, 51 to 52
installing software, 46 to 47
miscellaneous, 52 to 53
paper feeding, 50 to 51
print quality, 48 to 50
printer, 43 to 53

Q
Quality Option setting, 10
Quality/Speed setting, 14

S
Safety instructions, 58 to 59
Self Adhesive Sheets, 17
Semigloss Photo Paper, 17
Slow printing, 48
Software

Print CD, 27 to 30
problems, solving, 46 to 47
uninstalling, 53 to 54

Stopping printing
Windows, 12

System requirements, 57

T
Transparencies, 17
Transporting printer, 42
Troubleshooting, 43 to 55
Type setting, 10

U
Uninstalling software, 53 to 54
USB, 57
Utilities

Head Cleaning, 31 to 32
Nozzle Check, 32
Print Head Alignment, 39 to 40

W
Windows

basic printing, 9 to 12
system requirements, 57
uninstalling software, 53
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Epson Ink Jet Papers and Ink Cartridges
Use Epson paper and inks to get the same photo quality results that have earned Epson’s printers
all of their awards! Epson papers are specially coated to work with genuine Epson inks. Here are
details about just a few of Epson’s papers: 

Premium Glossy Photo Paper
Water-resistant, photographic-weight paper with a high gloss finish. 
Perfect for all photographic applications and available in a variety of sizes.
Framing is recommended for this paper type.

Glossy Photo Paper 
Photo quality, heavyweight glossy paper available in a variety
of sizes, including letter and 4 x 6. Perfect for color photo
keepsakes of snapshots, reprints, and enlargements.

Epson Matte Paper Heavyweight
Heavyweight, bright white, ultra-smooth coated paper with a matte finish.
Perfect for photographs, signs, and crafts.

Epson Ink Cartridges 
For best results, always use these genuine
Epson ink cartridges:

Black: T048120
Cyan: T048220
Magenta: T048320 
Yellow: T048420
Light Cyan: T048520 
Light Magenta: T048620
Color Multipack: T048920

For more information on other Epson products and fun project ideas,
look for the Epson Print Lab Series at www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.

Paper name Size Part number

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

Epson Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

Epson Glossy Photo Paper Borderless 4 x 6 inches S041809

4 x 6 inches, perforated edges S041134/S041671

Letter (8.5 x 11 inches) S041141/S041649/ 
S041272/S041271

Epson ColorLife® Photo Paper Letter (8.5 x 11 inches) S041500

Epson Matte Paper Heavyweight Borderless 8 x 10 inches S041467

Letter (8.5 x 11 inches) S041457

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Ultra Premium Glossy Photo Paper Borderless 4 x 6 inches S041934

Letter (8.5 x 11 inches) S041935

Epson Premium Glossy Photo Paper Borderless 4 x 6 inches S041727/S041808

Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Letter (8.5 x 11 inches) S041286/S041667

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

Epson Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

Epson Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153

Epson Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches), S041606
perforated edges

Epson Photo Stickers® A6 (4.1 x 5.8 inches) S041144

Epson Semigloss Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1001

PremierArtTM Matte Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1002
for Epson

The availability of paper types varies by location.

How To Order Epson Ink and Paper
You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find 
the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit
www.epsonstore.com (U.S. sales only). In Canada, please call (800-463-7766) for dealer referral.

Epson Ink Cartridges
Black: T048120 Cyan: T048220 Magenta: T048320
Yellow: T048420 Light Cyan: T048520 Light Magenta: T048620



Epson Ink Jet Papers and Ink Cartridges
Use Epson paper and inks to get the same photo quality results that have earned Epson’s printers
all of their awards! Epson papers are specially coated to work with genuine Epson inks. Here are
details about just a few of Epson’s papers: 

Premium Glossy Photo Paper
Water-resistant, photographic-weight paper with a high gloss finish. 
Perfect for all photographic applications and available in a variety of sizes.
Framing is recommended for this paper type.

Glossy Photo Paper 
Photo quality, heavyweight glossy paper available in a variety
of sizes, including letter and 4 x 6. Perfect for color photo
keepsakes of snapshots, reprints, and enlargements.

Epson Matte Paper Heavyweight
Heavyweight, bright white, ultra-smooth coated paper with a matte finish.
Perfect for photographs, signs, and crafts.

Epson Ink Cartridges 
For best results, always use these genuine
Epson ink cartridges:

Black: T048120
Cyan: T048220
Magenta: T048320 
Yellow: T048420
Light Cyan: T048520 
Light Magenta: T048620
Color Multipack: T048920

For more information on other Epson products and fun project ideas,
look for the Epson Print Lab Series at www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.

Paper name Size Part number

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

Epson Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

Epson Glossy Photo Paper Borderless 4 x 6 inches S041809

4 x 6 inches, perforated edges S041134/S041671

Letter (8.5 x 11 inches) S041141/S041649/ 
S041272/S041271

Epson ColorLife® Photo Paper Letter (8.5 x 11 inches) S041500

Epson Matte Paper Heavyweight Borderless 8 x 10 inches S041467

Letter (8.5 x 11 inches) S041457

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Ultra Premium Glossy Photo Paper Borderless 4 x 6 inches S041934

Letter (8.5 x 11 inches) S041935

Epson Premium Glossy Photo Paper Borderless 4 x 6 inches S041727/S041808

Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Letter (8.5 x 11 inches) S041286/S041667

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

Epson Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

Epson Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153

Epson Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches), S041606
perforated edges

Epson Photo Stickers® A6 (4.1 x 5.8 inches) S041144

Epson Semigloss Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1001

PremierArtTM Matte Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1002
for Epson

The availability of paper types varies by location.

How To Order Epson Ink and Paper
You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find 
the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit
www.epsonstore.com (U.S. sales only). In Canada, please call (800-463-7766) for dealer referral.

Epson Ink Cartridges
Black: T048120 Cyan: T048220 Magenta: T048320
Yellow: T048420 Light Cyan: T048520 Light Magenta: T048620
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